	Introduction to SPSS: Task Sheets


	References to the relevant page in the "Introduction to SPSS v.13 Notes" 
application task guide are indicated in the right hand margin, e.g. …
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	 Task 1 
	

	Quantitative data analysis requires an appreciation of the type of variables that are being analysed. When we use computers to undertake such analysis, we normally 
have to define the type of variable before we can enter any data.

· Consider each of the following questions and how the answer might be coded.

Decide what “type” of variable each would be, and it’s likely format 
(i.e. number of characters, digits, decimal places etc.).



How old is your house?


What is your annual income?

How much rent or mortgage costs do you pay?


What is the total floor area of your house?


What was the date when you first started on Housing Benefit?

How do you think the Housing Benefit system could be improved?


How long does it take you to travel to work?


Have you had major repairs done on your house in the last year?


What is your marital status?


Where were you born?


What is your address?


Why did you decide to study SPSS?


Which daily newspapers do you read regularly?



	


	 Task 2 
	

	· Locate “SPSS 13.0 for Windows” on the Start menu (under “LBSS Courseware”) and Open SPSS.

It can take a few minutes for SPSS to load onto the computer in the labs.

Your tutor will explain some of the key concepts in the design and use of this software, and provide a short overview of the menus and toolbars.
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	 Task 3 
	

	The first stage in creating a Data file in SPSS is to define the variables.

· Create an SPSS file into which you could record the data that might be collected using the following short questionnaire:

Q.1
How many people, including yourself, are there in your household?


Q.2
How many of them are under 16 years of age?


Q.3
How old are you?


Q.4
Have you had major repairs on your house in the last year?
( Yes
( No
Q.5
What is your sex?
( Female
( Male
Q.6
How would you rate the shopping facilities where you live?


( very good
 ( good
( fair
( poor
( very poor

Q.7
Where do you live?
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	 Task 4 
	

	The data from five completed questionnaires is listed in the table below.

· Enter the data into the SPSS file that you have created.


	
( p.5  

	Respondent
	Q.1
	Q.2
	Q.3
	Q.4
	Q.5
	Q.6
	Q.7

	A
	3
	1
	37
	No
	Male
	good
	Glasgow

	B
	2
	1
	19
	No
	Female
	fair
	Glasgow

	C
	1
	0
	31
	No
	Male
	poor
	Paisley

	D
	3
	0
	54
	Yes
	Female
	fair
	Edinburgh

	E
	1
	0
	refused
	No
	Female
	good
	Glasgow


	 Task 5 
	

	· Although we will not be using this particular file again, for practice:
Save the file you have created in the H:\My Documents folder.
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	 Task 6 
	

	· Open SPSS Data file “Employee Data.sav” in folder C:\Program Files\SPSS
The file contains data a researcher extracted from a bank’s employee records 
(rather than from a questionnaire) in an investigation into discrimination in 1987.

Information was collected on the following:

ID
Employee code  (a unique identifier assigned by the researcher)
GENDER
Gender of employee

BDATE
Date of birth
EDUC
Educational level (years)
JOBCAT
Employment category

SALARY
Current salary
SALBEGIN
Beginning salary (when they started with company)

JOBTIME
Months since hire
PREVEXP
Previous experience (months)
MINORITY
Minority classification (i.e. whether ethnic minority)
Before starting on the detailed analysis of any data set, it is sensible to make a preliminary inspection of the data by generating some univariate descriptive statistics for all the variables. As well as highlighting possible errors, spurious or extreme values in the data, it can provide an insight into the sort of results that will be obtained when you undertake any subsequent statistical testing. It will also allow you to determine whether there are likely to be sufficient numbers of observations for some of the analysis that you may have been considering, and whether there may be a  bias in the type of respondents or cases included.
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	 Task 7 
	

	· For which of the variables would it be sensible to produce frequency tables?

· Use the Frequencies procedure to produce frequency tables for these variables.

Note that it is possible to analyse several variables at the same time.

As soon as you run the procedure, a new window will appear – the Output Viewer.
This contains the results output, together with any error messages. The results from subsequent analyses will be appended to the file displayed in the Output Viewer.

The easiest way of switching between windows is to click on the appropriate button
on the taskbar at the foot of the screen.
It is also possible to use the Frequencies procedure to produce a graph (chart) of the frequency distribution in addition to, or instead of, displaying the frequency table.

· Produce suitable charts (pie- or bar-charts) for some of these variables.

· Examine the tables and charts that have been generated and interpret the results.

Don't attempt to edit the tables or charts – this is covered in a later task.
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	 Task 8 
	

	The Frequencies procedure has options to produce statistical measures of central tendency and dispersion. For nominal variables, the mode is usually the only meaningful statistic, while, for ordinal variables, the median can also be a useful measure.  For scale variables, however, several other statistics can be computed.

· For which of the variables in the “Employee Data” file, would it be sensible to compute arithmetic means?

· Use the Frequencies procedure to generate statistical measures of central tendency and dispersion for these particular variables.
Also produce histograms, to summarise the data graphically.

Make sure you do not select frequency tables – Why?
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	 Task 9 
	

	In order to aid in the analysis of a data file, it is sometimes necessary to derive (compute) a new variable from some of the other variables. For example, we might have information about both the number of children and the number of adults in a household but not the total number of people in the household. We could, however, compute such a variable by adding the two other variables together.

In the “Employee Data” file, calculate each individual employee’s total period of work experience, i.e. the sum of ‘months since hire’ plus ‘previous experience’.

· Compute a new variable called  EXPERT  “Total months of experience”

Make sure that you are in the Data Editor (rather than the Output Viewer).

Note that in Compute formulas:
the star * symbol means multiply
the slash / symbol means divide.
· The new variable will appear to the right of the last variable in the file.
Visually inspect the values that have appeared.  Do they look reasonable?

Another useful calculation would be to determine the percentage increase in salary from when each individual started to the time when the survey was undertaken.

· Compute a new variable called  PCRISE  “% Rise in Salary”

The formula will be:  (SALARY – SALBEGIN) / SALBEGIN * 100
· Visually inspect the values that have appeared.  Do they look reasonable?

· As the period each employee has worked with the bank also varies (JOBTIME), 
the “% Rise in Salary” may not be particularly useful measure on its own.

· Compute a revised version of PCRISE that takes into account the length of time each individual has been employed.

· Use the Frequencies procedure to analyse the new variable.
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	 Task 10 
	

	Another useful data transformation is to recode an existing variable into a smaller number of values (or categories). There might be very few cases with some particular values for a nominal variable, for example, and combining them together into an ‘other’ or ‘miscellaneous’ category will make the analysis easier to comprehend.
Similarly, if a scale variable has a very large number of values, it may be easier to spot any patterns in the data if the values are banded or regrouped into a smaller number of categories, for some types of analysis.

Reducing the number of values for any variable inevitably means losing information. Consequently, it is almost always better to create an additional, new variable that contains the recoded values of the existing variable, rather than simply replacing or over-writing the old values of the existing variable.

In the “Employee Data” file, the variable PREVEXP “Previous Experience” is measured in months but it might be helpful to reduce this to only four or five categories, such as:


“less than 12 months”, “1-4 years”, “5-9 years”, “10 years or more”.

· Use the Recode procedure to recode PREVEXP “Previous Experience (months)” into a new variable called PREVEXP2 “Previous Experience”

Tip: If you want to ensure that each of the new bands had roughly the same number of cases, analyse the variable using the Frequencies procedure (without tables) and select “Cut points for … equal groups” in the Statistics options. You can then use the values listed in the output as the limits in the Recode. 
· Ensure that you assign the new variable a variable label and value labels.

· Use the Frequencies procedure to generate a chart and appropriate statistical measures of central tendency and dispersion for the new variable.

Hint: What type of measurement scale is the new variable?
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	 Task 11 
	

	· Save your work.
Note that, in SPSS, there are separate files for the data and for the output.
 
Save the SPSS Data file on your H: (home) drive or on floppy disk.
Call the file “Employment.sav”

You need to be in the Data Editor window in order to save a (.sav) data file.
· Save the SPSS Viewer document file on your H: (home) drive or on floppy disk.
Call the file “Employment 1.spo”.

You need to be in the Output Viewer window in order to save a (.spo) viewer file.
· Exit from SPSS and Log out.
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	 Task 12 
	

	· Locate “SPSS 13.0 for Windows” and Open SPSS.

· Re-open the SPSS Data file “Employment.sav” which you saved on your 
H: (home) drive or on floppy disk.
Alternatively, open the file of the same name in folder Q:\PostgradIT
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	 Task 13 
	

	Frequencies and Descriptives procedures allow you to produce descriptive statistics, but you will often want to examine how two or more variables are associated (not necessarily related) to one another. Contingency tables (cross-tabulations) provide a summary of the number of cases (observations) that have particular combinations of values for two or more variables. The Crosstabs procedure is normally used when the variables are nominal or ordinal.

· Use the Crosstabs procedure to examine the association between gender and ethnic minority status of employees and the type of job (employment category).

· Examine the output – check that you understand the differences between the 
row, column and total percentages.

Do the results suggest possible discrimination?
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	 Task 14 
	

	If the company was discriminating, on ethnic or gender grounds, this might be reflected in differences in salaries. We are no longer looking at the association between two nominal/ordinal variables, but rather between one scale variable and one nominal/ordinal variable.

· Use the Explore Data procedure to examine whether salary was dependent upon gender.

· Repeat the exploration but with minority status as the independent factor.

· Do these results provide any evidence for possible discrimination?
	( p.17


	 Task 15 
	

	Salary might have been dependent upon not one but several factors. More advanced statistical techniques can be used to test such hypotheses but some indication can be obtained by comparing the mean salaries for all the combinations of employment category, gender and ethnic minority status.

· Use the Compare Means procedure to examine whether salary was dependent upon these three variables.

Note that you will have three “layers” – one for each independent variable.
· Do these results provide any evidence for possible discrimination?
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	 Task 16 
	

	It is quite possible that an employee’s salary when they started was dependent upon their previous experience.

· Produce a Simple Scatterplot graph of
Beginning Salary plotted against Previous Experience (months).

· Examine the output.  Is there any apparent pattern?
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	 Task 17 
	

	Scatterplot graphs can also be produced that separate out the plotted points for each value of a third variable (which will usually be a nominal variable).

Continuing the investigation into possible discrimination, we can plot the same variables again but this time differentiating between genders or between minority statuses.

· Produce the same scatterplot as in Task 16 but, this time,

Paste the Gender variable into the Set Markers by box.

Different markers will be used in the graph to indicate whether a particular point corresponds to a male or a female employee.
· Repeat, but with Minority Status in the Set Markers by box.

· Examine the output.  Is there any apparent pattern?
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	 Task 18 
	

	In Task 9 you computed a variable that measured the percentage increase in salary between when an employee started and when the survey was undertaken. Another indicator of possible discrimination would be that this percentage change also varied by gender and minority status.

· Which descriptive statistics procedure(s) might you use to test this hypothesis?

· Undertake the analysis you have suggested.
	


	 Task 19 
	

	· Save the SPSS Viewer document file on your H: (home) drive or on floppy disk.
Call the file “Employment 2.spo”.

You need to be in the Output Viewer window in order to save a (.spo) viewer file.

There is no need to save the SPSS Data file on this occasion as the data has not changed.
· Exit from SPSS and Log out.
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Editing the Output from SPSS
( p.10-12
	 Task 20 
	

	The results output from SPSS – the SPSS Viewer document files with a file name extension of .spo – can only be opened in SPSS.  They cannot be opened in Word.

It is, however, not necessary to have the corresponding SPSS data file open before looking at a SPSS Viewer document.

· Find and open Windows Explorer

Find the Viewer document file “Employment 2.spo” that you saved in Task 19.

Alternatively, use the file of the same name in folder Q:\PostgradIT

Open the file (double-click on the name, or choose Open from the File menu)

SPSS will load with the file open in the Output Viewer window.
A blank SPSS Data file will also be opened.
Alternatively

· Locate “SPSS 13.0 for Windows” and Open SPSS.

At the SPSS initial dialogue box, choose Type in Data.

From the File… menu, choose Open…

Find and Open the “Employment 2.spo” SPSS Viewer document file that you saved in Task 19.
Alternatively, open the file of the same name in folder Q:\PostgradIT

Use the Files of type box to change the type of files that are listed in the list box
– you are looking for a Viewer document (*.spo).

By default, SPSS assumes that, if you are in the Data Editor, you will want to open an SPSS Data file (.sav), and if you are in the Output Viewer, you will want to open a Viewer document (.spo).
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	 Task 21 
	

	In SPSS it is very easy to generate a large volume of results in the output viewer very quickly, either by design or by accident, such as running a frequency table for a scale variable. There will, inevitably, be some output that you do not want to keep and which can be safely deleted. There will, however, also be output that you might want to retain but do not want to print out.

· Practice moving around the output Viewer, noting the effect of clicking on an item in the left-hand Outline pane on what appears in the right-hand Results pane, and vice-versa.

· Try out the Output Viewer’s Hide and Show facilities.

· Try out the Delete facilities and the (limited) Undo capabilities.

If you chose Print from the File menu, by default, everything that is visible in the right-hand Results pane will be printed. Items that are hidden will not be printed.

You are not required to print any of the results as part of this task.
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	 Task 22 
	

	As indicated previously, Word cannot read SPSS Viewer document files, but you will often want to include results generated in SPSS in a report produced using Word.
You will want to avoid having to retype any tables, however. Not only is it time-consuming, but there is also the risk of transcription and typing errors.

· Open a new document in Microsoft Word, while still leaving SPSS open.
From the Start button, select: Microsoft Office > Microsoft Word
· Switch back to SPSS Viewer window
Use the buttons on the taskbar at the foot of the screen to switch between programs.
· Select a table that you have produced in SPSS (by clicking once anywhere on the table) and copy the table into the Word document, firstly using Paste Special and secondly using Paste.

· Note the effects of the two different methods of pasting. Only the second method permits editing of the table, including changes to fonts and borders, within the Word document.

· Those familiar with Word may want to try the Table AutoFormat command to quickly change the appearance of the table that has been copied across as text.
	( p.12


	 Task 23 
	

	It is also possible to make changes to the appearance of tables within the SPSS Viewer itself. 

· Clicking once on a table will select it (e.g. in order to delete or copy it.)
Double-clicking on a table will open it for editing.

· Try out the various options available for editing, on some of the tables you have created. For example:

If some statistics appear as a group of asterisks, this indicates that there is insufficient space to display the number. The easiest solution is to select Autofit, which is found in the Format menu.

· You can also change the overall appearance of a table by using the TableLooks command, which is also found in the Format menu.

· You can transpose the rows and columns (i.e. rotate the content of the table so that rows and columns are swapped) by using the Transpose Rows and Columns command, which is found in the Pivot menu.
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	 Task 24 
	

	Copying a graph into a Word document is similar to the process for copying a table.

· In the SPSS Viewer window, select a graph that you have produced (by clicking once anywhere on the graph), and copy it into the Word document.

You cannot make any further major changes to the graph inside Word.
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	 Task 25 
	

	As with tables, it is possible to edit a graph within the SPSS Viewer.

· In the SPSS Viewer window, edit any of the graphs that you have produced 
(by double-clicking anywhere on the graph).

Note that the editing of a graph takes place within another window – the Chart Editor.
Once you have made the desired changes, the Chart Editor window should be closed. 
The graph in the right-hand Results pane in the SPSS Viewer window will automatically reflect any changes that have been made.
· Almost all features of a graph can be changed, including fonts, colours and patterns. Try out the various options available by clicking on different elements
of the graph, e.g. titles, legends, and pie-chart segments.
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	 Task 26 
	

	· Export the contents of the Output Viewer as a Word/RTF document.

· Open the document you have just created in Microsoft Word.

Note that from version 13 onwards, SPSS output can also be exported as a PowerPoint presentation, with each table or graph becoming an individual slide in the presentation.
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Changing the Default Settings in SPSS

	 Task 27 
	

	Although SPSS provides editing tools to change the appearance of the output, it is also possible to change some of the default settings so that the output is closer to what you want to achieve.

· From the  Edit  menu select  Options…  

The most likely settings that you might want to change are:

· On the General tab:
· Display names  or  Display labels  for variables in dialog box lists.

· List variables in  Alphabetical  order  or 
in the order in which they occur in the  File.

· On the Output Labels tab:

· Display  Names  or  Labels  or  Names and Labels 
for variables and values in outputs from any analysis.

· On the Charts tab:

· Cycle through colors then patterns  or  Cycle through patterns
(i.e. no colours) for Fill Patterns and Line Styles in charts.

· On the Pivot Tables tab:

· Select a  Table Look  that you want to use as the default design.
The lab computers are initially set to  Avant-garde (narrow).

· Adjust column widths for  Labels only  or  Labels and data.
· On the Data tab:

· Width  and  Decimal  places to be used as the default Display Format 
for New Numeric Variables.

If SPSS is installed on your own computer, any changes in settings will remain in effect until you change them – they do not reset each time you use SPSS. In the computing labs, SPSS will always revert to the preconfigured settings after you have logged off.
	


Importing and Exporting Data into and out of SPSS

	 Task 28 
	

	SPSS allows data to be read from several types of text, database and spreadsheet file, including files created in Excel, Access, dBase, 1-2-3, SAS and, from version 14, Stata.

Task:  To import data from an Excel spreadsheet file into a SPSS data file.
· From the  File  menu, select  Open  then  Data… 
From the  Files of type:  pull-down list, select  Excel (*.xls)

Using the  Look In  box, find and open the file  Q:\PostgradIT\People.xls

Tick the box for  Read variable names from the first row of data

If there were no variable names in the first row, you would clear the tick box, 
and SPSS would name the variables V1, V2 etc.
There is only one worksheet in this particular spreadsheet file but, if there were more, you would need to select the required  Worksheet.

Click on the  OK  button to import the data into a new SPSS data file.


	


	 Task 29 
	

	SPSS allows data to be saved in several different file formats, including Excel, dBase, 1-2-3, SAS, tab-delimited and, from version 14, Stata.

Task:   To create an Excel spreadsheet file from a SPSS data file.
· From the  File  menu, select  Save As…
From the  Save as type:  pull-down list, select  Excel 97 and later (*.xls)

Using the  Save In  box, select the folder where you want to save the file.

Type in an appropriate name for the file in the  File name  box.
If you want to save only selected variables, rather than them all:

Click on the  Variables… button.
In the  Keep  column, deselect those variables you do not want to copy.
Click on the  Continue  button. 

If you select  Write variable names to spreadsheet
the variable names will be written into the first row of the spreadsheet. 

If you select  Save value labels where defined instead of data values
the value labels will be written into the cells in the spreadsheet rather than the data values, i.e. what you would see if the value labels are turned on in the Data Editor view.

Click on the  Save  button to create the new Excel spreadsheet file.

Alternative Method of Copying Data between Excel and SPSS

It is also possible to copy selected cells from within a spreadsheet file into an existing SPSS data file, in the same way as copying within a spreadsheet.

In Excel:


Open the relevant spreadsheet file.

Select (highlight) the cells you want to copy.

From the  Edit  menu, choose  Copy  (or press Ctrl+C ).

In SPSS:

Open the SPSS data file into which you want to copy the data.

Ensure that you are in the SPSS Data Editor window.

Go to the point at which you want to insert the data
or highlight the cells that you want to overwrite.

From the  Edit  menu, choose  Paste  (or press Ctrl+V ).

If you use this method to insert new variables, SPSS will name the variables VAR00001, VAR00002 etc.
This method of copying selected cells also works in reverse, allowing selected data cells to be copied from an SPSS data file to an Excel spreadsheet. The variable names, however, cannot be copied across from SPSS to Excel.


	


	 Task 30 
	

	Task:  To import data from an Access database file into a SPSS data file.
· From the  File  menu, select  Open Database  then  New Query… 
From the type of  Data Source, select  MS Access Database

Click on the  Next >  button.

Browse to find and select the file Q:\PostgradIT\EastEnd Households.mdb
Select the fields (variables) that you wish to retrieve (import) into SPSS 
by selecting them in the left-hand box and dragging them into the right-hand box..

Tips:
Clicking on the  +  to the left of the table name, displays/hides the fields in that table.
Dragging a table from the left-hand box to the right-hand box will select all the fields in the table.

If you want to select particular cases to retrieve, click on the Next > button. (Warning: This should only be attempted if you know how to use Access.)

Otherwise, to retrieve all cases, click on the  Finish  button to import the database data into a new SPSS data file.


	


Selecting Cases
	 Task 31 
	

	· Open the SPSS Data file “4000.sav” in folder Q:\PostgradIT
The file contains three variables – Sex, Marital status and Age – for 4000 adults.
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	 Task 32 
	

	There are many occasions in data analysis when we want to exclude cases, perhaps because they are atypical or for which the data is unreliable. There are also occasions when we want to focus the research on a specific sub-group. In both cases, the procedure that is used is Select Cases.

· Say that we wanted to know the age distribution of divorced men.

It is desirable to firstly check how many such cases there are in our data file.

Use the Crosstabs procedure to produce a contingency table for the two nominal variables.

Examine the output.  How many of the 4000 individuals were male and single?

· Use the Select Cases procedure to select only those observations that are both Male and Divorced.

Hint: You can check on the value labels for a variable by double-clicking on the variable name in the Data Editor.
· Use the Frequencies procedure to produce appropriate statistical measures of the central tendency and dispersion of the Age variable for these male divorcees.
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	 Task 33 
	

	The Select Cases procedure is normally used to extract observations that meet particular criteria. The procedure can also be used, however, to extract a random sample of cases.

· Use the Select Cases procedure to turn off the selection of male divorcees, i.e. select All cases.

· Use the Frequencies procedure to produce appropriate statistical measures of the central tendency and dispersion of the Age variable.

The results should now be for all 4000 cases.

· Use the Select Cases procedure again but this time select the Random sample of cases.

Click on the Sample button

Specify a Sample Selection of:  Exactly 100 cases from the first 4000 cases
· Repeat the Frequencies procedure for Age and compare the results.
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Using Syntax Commands
	 Task 34 
	

	It is possible to undertake data analysis in SPSS using only the menu system and graphical pop-up windows, but it is also possible to type in a series of instructions, known as syntax commands, to achieve the same ends.

These syntax instructions can be typed from scratch, provided you know the correct format of the commands. Details of the syntax commands can be found in the SPSS manuals, which are available in the labs in the folder Q:\SPSSmanuals

The “Brief Guide” manual provides an overview of how to use SPSS, while the “Base User’s Guide” manual covers data transformation and the most commonly used statistical procedures.
For those new to SPSS, it may be easier and more reliable to generate the commands by working through the menus and pop-up windows.

When you run any analysis using the normal Windows menu selection system, instead of clicking on the final OK button to run the procedure, click on the Paste button instead.

· Repeat the selection of a random sample of 100 cases undertaken in Task 33, 
but this time, do not click on the  OK  button to run the procedure; 
instead, click on the  Paste  button.

The syntax commands required to generate the random sample will be pasted 
into a file in the Syntax Editor window.
A new syntax window will be created if one is not already open.
· Repeat the Frequencies procedure for the variable Age.
Again, do not click on the  OK  button to run the procedure; 
instead, click on the  Paste  button.

The syntax commands for the Frequencies procedure will be appended into 
the file in the Syntax Editor window.
· Switch to the Syntax Editor window, and scroll through the commands to see what they look like. Any of these commands can be edited, just as in a text editor. 

· Run (execute) the syntax commands:


Go to the start of the first command line.

From the Run menu, choose All, 

or, alternatively, click on the “play” ( button on the toolbar.

· Compare the results of the Frequencies procedure with those that you obtained when you took the previous random sample.

· Run the syntax commands a few more times.  Compare the results.
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